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Please read the following important information

1.	 You can download and print the Class Notes for personal use, but you may not share them. 

2.	 Once you have watched all the videos and completed all the quizzes, reflections, tasks and assessments 
successfully, you can download your certificate and print it. 

3.	 If you wish to earn SACE Professional Development (PD) points for this session, you must complete all the online 
assessments in the session successfully. Our system will notify us of your success, and we will send the points 
allocation request to the South African Council for Educators (SACE). 

4.	 Remember that devices and apps are updated all the time. The device specifications and features that you see 
here might differ slightly from those of the device you are using. The app features and icons that you see here 
might also differ slightly from the app in which you are working.
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Outcomes and content
Outcomes of the session

By the end of the session, the participant will be able to: 

•	 understand the benefits of using online and mobile 
Microsoft Applications in the classroom

•	 use Microsoft Word Online and on mobile devices for 
creating and editing documents

•	 use Microsoft Excel Online and on mobile devices for 
managing data and creating charts

•	 use Microsoft PowerPoint Online and on mobile devices for 
creating engaging presentations

•	 use Microsoft OneNote Online and on mobile devices for 
organising lesson plans and collaborating with learners

•	 use Microsoft OneDrive Online and on mobile devices for 
storing and sharing documents and files with learners

•	 understand how to switch seamlessly between desktop, 
online, and mobile versions of Microsoft Applications

Content of the session

This session will focus on:

•	 an overview of how to use Microsoft Word, Excel, 
PowerPoint, OneNote, and OneDrive on a desktop 
computer

•	 how to use Microsoft Word, Excel, PowerPoint, OneNote, 
and OneDrive Online and on mobile devices

•	 the benefits of using online and mobile Microsoft 
Applications in the classroom

•	 the differences between desktop, online, and mobile 
versions of Microsoft Applications
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Overview
Welcome to Session 8 of Microsoft 365. This session is called Mastering online and mobile 
Microsoft Apps for classroom success. 

Although the rest of this course focuses on using your laptop, in this session, we will be exploring 
how to use Microsoft Apps online and on mobile devices to enhance your teaching experience. 

You will learn when it is useful to use various Microsoft Apps on your laptop, and when it could 
be useful to use the web-based or mobile versions of the same apps. In this way, you will 
develop your digital fluency.

For demonstration purposes, the mobile device we use for this session is an Android device. The 
Microsoft Apps can be downloaded on other devices, such as IOS and Windows devices.

If you would like to learn how to use the apps we will deal with during this session in much more 
detail, we strongly encourage you to enrol for the rest of the sessions in this course. 

In Sessions 1–3, we take your Microsoft Word skills to an expert level. In Sessions 4 and 5, we 
do the same with your Excel skills. In Session 6, you will learn all about using PowerPoint, and in 
Session 7, we take a deep delve into the features and functions of OneNote.

Remember that devices and apps are updated all the time, so the app features and icons that 
you see here might differ slightly from the app in which you are working.
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Let’s recap what you know about  
Microsoft Word

Microsoft Word

During Sessions 1, 2 and 3 of this course we dealt with the 
features and functions of using Microsoft Word on a computer 
in great depth. Here is a summary of some of the useful 
functions of the desktop app.

•	 Formatting Options for visual appeal and readability, 
including Font Style, Size, Colour, Headings, Subheadings, 
and Bullets.

•	 Page layout settings for Margins, Orientation, Size, Page 
Breaks, Section Breaks, and Columns.

•	 Tables and charts for presenting data or organising 
information and illustrating trends or patterns.

•	 Review Features for proofreading and editing, including 
Spelling and Grammar Checker, Track Changes, and 
Comments.

•	 Printing and Sharing Options, including saving in various 
formats such as PDFs and sharing via email or cloud storage 
services like OneDrive.

Reflection
•	 Make notes in your PD Journal.

•	 Think about three ways in which you use Microsoft Word 
as a teacher. 

•	 If you have not used it, why not?
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Using Microsoft Word Online 

You can use Microsoft Word Online.

1.	 Sign into your Microsoft Account.

2.	 Sign into Microsoft Word Online.

3.	 Create a new document by clicking on the New Button and 
selecting a blank document or a template.

4.	 Format text by highlighting it and selecting the appropriate 
Formatting Option from the Toolbar, such as Bold, Italic, 
Underline, Font Size, and Font Colour.

5.	 Add images by clicking on the Insert Tab, selecting Pictures, 
and choosing an image from your device or the internet. 
Add tables by clicking on the Insert Tab, selecting Table, and 
choosing the size and format of the table.

6.	 Save your document by clicking on the Save Button. Share 
your document with learners by clicking on the Share Button 
and entering their email addresses. You can choose whether 
they can edit the document or just view it.

Task
•	 Open a Microsoft Word Document on your computer and 

add some text.

•	 Open the same document on Microsoft Word Online and 
format the text.
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Task
•	 Open the same document you worked in earlier, but now 

open it on the Microsoft Word mobile app and review the 
spelling.

•	 Was it easy to access and work with the same document 
across the three versions of Microsoft Word? 

Using the Microsoft Word mobile app

You can use the Microsoft Word mobile app.

1.	 Go to your device’s App Store. If you are using an Android 
device, this will be the Google Play Store.

2.	 Download and install the Microsoft Word App on your 
mobile device. 

3.	 Once you’re in the app, you’ll notice that it looks very similar 
to the desktop version of Word, but with some differences 
in the layout, to suit mobile devices.

4.	 To start a new document, tap on the Plus Sign Icon in 
the bottom right-hand corner of the screen. You’ll then 
be prompted to choose a template or start with a blank 
document.

5.	 To access Formatting Options, simply highlight the text you 
want to format and tap on the Paintbrush Icon in the top 
Menu Bar. Here, you’ll find options for Font, Font Size, Bold, 
Italic, Underline, and more.

6.	 To collaborate on a document, tap on the Share Icon in the 
top right-hand corner of the screen. From there, you can 
invite others to collaborate by entering their email addresses 
or sending them a link.

7.	 You can save your documents to the cloud by linking to 
your Microsoft OneDrive Account. This allows you to access 
your documents on any device with the Word App installed 
and makes it easy to share documents with others.

8.	 To switch between Editing and Reading Mode, tap on the 
Pencil or Book Icon in the top Menu Bar. To view your 
document in full-screen mode, tap on the arrows in the top 
right-hand corner of the screen.
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Desktop, online or mobile app?

To enhance your digital fluency, use this table showing a 
comparison of Microsoft Word on a desktop, in a browser and 
on a mobile device to decide when you would like to use which 
version of the app.

Feature

Ability to create captions, 
citations, bibliographies, tables of content

Yes No No

Apply styles to your documents Yes No No

Unlimited page layouts, reviewing, and editing Yes Yes Yes

Can work without internet connection Yes No No

Free No Yes No

You will notice that the desktop version of Microsoft Word has 
the most features available, but it is also not free. The ideal case 
scenario is for you have Word on your computer, where you 
can do complex word processing tasks. You can then use Word 
Online and the Word App on your mobile device on the fly, and 
at any time. However, if you do not own a computer, the app is 
very useful in a browser or on a smartphone or tablet too.
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Reflection
•	 Make notes in your PD Journal.

•	 Think about three ways in which you are currently using 
Microsoft Excel as a teacher. 

•	 If you have not used it, why not?

Let’s recap what you know about  
Microsoft Excel 

Microsoft Excel

During Sessions 4 and 5 of this course, we dealt with the 
features and functions of using Microsoft Excel on a computer 
in great depth. Here is a summary of some of the useful 
functions of the desktop app.

•	 Data can be entered and organised in rows and columns, 
making it easy to sort and filter data for creating accurate 
reports.

•	 Excel Formulas and Functions can calculate values based on 
entered data.

•	 Charts and graphs can be created and customised to 
visualise data.

•	 Conditional Formatting can be used to highlight important 
information, and data validation ensures correct data entry.

•	 Excel Workbooks can be shared with others and 
collaboration is possible through comments and feedback.
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Using Microsoft Excel Online

You can use Microsoft Excel Online.

1.	 Sign into your Microsoft Account.

2.	 Sign into Excel Online.

3.	 Create a new workbook or open an existing one.

4.	 Creating a marksheet: To create a marksheet, start by 
creating a new workbook and adding your learner’s names 
and test scores. Once you have your data entered, you can 
use Excel’s built-in Formulas and Functions to calculate 
averages, minimums, maximums, and more.  

5.	 Creating graphs and charts: Once you have your data 
entered, you can use Excel’s charting capabilities to create 
graphs and charts to help visualise your data. Simply 
highlight the data you want to use and click on the Insert 
Tab to choose the type of chart you want to create.  

6.	 Collaborating with learners: Excel Online allows you to 
collaborate with your learners in real-time. To do this, 
simply share your workbook with your learners and give 
them Editing Access. They can then add their own data, 
make changes, and work together with you on the same 
document.

Task
•	 Open a Microsoft Excel Workbook on your computer and 

add some data.

•	 Open the same workbook on Microsoft Excel Online and 
format the workbook.



© Via Afrika – These pages may not be shared.8

Using the Microsoft Excel mobile app

You can use the Microsoft Excel mobile app.

1.	 Go to your device’s App Store. If you are using an Android 
device, this will be the Google Play Store.

2.	 Download and install the Microsoft Excel App.

3.	 Open the app and tap the Plus Sign Icon to create a 
new workbook. Choose a template or start with a blank 
workbook.

4.	 Enter data by tapping on the cell where you want to enter 
the data and start typing. You can use the on-screen 
keyboard or a Bluetooth Keyboard to enter data.

5.	 Format cells by tapping on the cell and then tapping on the 
Format Icon in the Toolbar. You can change the Font, Font 
Size, Cell Colour, and more.

6.	 Use Excel Formulas and Functions to perform calculations 
and analysis on your data. To enter an Excel Formula, tap on 
the cell where you want the result to appear and then tap 
on the Formula Icon in the Toolbar.

7.	 Save your workbook by tapping on the Save Icon in the 
Toolbar and choose a location to save it to.

8.	 Share your workbook by tapping on the Share Icon in the 
Toolbar and choose the method of sharing that you prefer.

Task
•	 Open the same workbook you used earlier on the 

Microsoft Excel mobile app. Can you see all your changes 
reflected in the workbook?

•	 Was it easy to access and work with the same workbook 
across the three versions of Microsoft Excel? 
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Desktop, online or mobile app?

To enhance your digital fluency, use this table showing a 
comparison of Microsoft Excel on a desktop, in a browser and 
on a mobile device to decide when you would like to use which 
version of the app.

Feature

Pivot tables Yes No No

Conditional formatting Yes No No

Advanced formulas Yes No Yes

Can work without internet connection Yes No Yes

Free No Yes No

Again, you will notice that the desktop version of Microsoft 
Excel has the most features available, but it is also not free. The 
ideal case scenario is for you have Excel on your computer, 
where you can do complex data processing tasks. You can then 
use Excel Online and the Excel App on your mobile device on 
the fly, and at any time.
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Reflection
•	 Make notes in your PD Journal.

•	 Think about three ways in which you are currently using 
Microsoft PowerPoint as a teacher. 

•	 If you have not used it, why not?

Let’s recap what you know about  
Microsoft PowerPoint 

Microsoft PowerPoint

During Session 6 of this course, we dealt with the features and 
functions of using Microsoft PowerPoint on a computer in great 
depth. Here is a summary of some of the useful functions of the 
desktop app.

•	 PowerPoint’s user interface contains a Ribbon with Tabs for 
various functions.

•	 The Home Tab includes Formatting Options for Font, 
Alignment, and Bullet Points.

•	 The Insert Tab includes Multimedia Options like Pictures, 
Videos, Audio Files, Shapes, Charts, Tables, and Smartart 
Graphics.

•	 The Slide Master Feature allows you to create a consistent 
look and feel for your presentation.

•	 PowerPoint offers various View Options, including Normal, 
Slide Sorter, and Presenter View.

•	 Presenter View is especially useful for giving a presentation 
in front of an audience.

•	 Animations and Transitions can be added to slides to 
emphasise key points and create a smooth flow.

•	 Overuse of Animations and Transitions can distract from the 
content of the presentation.
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You can use the Microsoft PowerPoint mobile app.

1.	 Go to your device’s App Store. If you are using an Android 
device, this will be the Google Play Store.

2.	 Download and Install the PowerPoint App.

3.	 Tap the Plus Sign Icon in the bottom centre of the screen to 
create a new presentation. Choose from a template or start 
with a blank presentation.

4.	 Tap the Plus Sign Icon in the bottom left corner to add a 
new slide. Choose from various slide layouts or create a 
custom one. 

5.	 Edit the slide by tapping on the Text or Image Boxes.

6.	 Select Design in the top Menu Bar to customise the design 
of your slides. Change the theme, colours, and fonts of your 
presentation.

Using Microsoft PowerPoint Online 

You can use Microsoft PowerPoint Online.

1.	 Sign into your Microsoft Account.

2.	 Sign into PowerPoint Online.

3.	 Open a new Blank Presentation. 

4.	 Choose a theme for your presentation.

5.	 Add content using Insert in the top Navigation Bar.

6.	 Add interactivity by selecting Interactive under Insert.

7.	 Collaborate and share using Share in the top Navigation 
Bar.

8.	 Present your slides in full-screen mode using Slide Show 
Mode and selecting From Beginning under the top 
Navigation Bar.

Task
•	 Open a Microsoft PowerPoint Presentation on your 

computer.

•	 Open the same presentation on Microsoft PowerPoint 
Online.

Using the Microsoft PowerPoint  
mobile app
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Task
•	 Open the same PowerPoint Presentation on the Microsoft 

PowerPoint mobile app.

•	 Was it easy to access and work with the same 
presentation across the three versions of Microsoft 
PowerPoint? 

7.	 Add Animations and Transitions by selecting Transitions 
in the top Menu Bar. Choose from various effects and 
customise the timing.

8.	 Tap the Save Icon in the top left corner to save your 
presentation. 

9.	 Share your presentation with others by selecting Share in 
the top Menu Bar and choosing a sharing method such as 
email or OneDrive.

10.	If you would like to present to an audience, connect your 
device to a projector or screen using a cable or wireless 
connection. Tap the Present Button in the top right corner. 
You’re ready to shine!

Desktop, online or mobile app?

To enhance your digital fluency, use this table showing a 
comparison of Microsoft PowerPoint on a desktop, in a browser 
and on a mobile device to decide when you would like to use 
which version of the app.

Feature

Create headers and footers Yes No No

Create custom animations Yes No No

Use the advanced design and review. Yes No No

Can work without internet connection. Yes No Yes

Free No Yes No
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Here, the desktop app also has the most features by far, but 
it is a paid-for app. The ideal case scenario is for you have 
PowerPoint on your computer, where you can create complex 
and advanced presentations. You can then use PowerPoint 
Online and the mobile app to make minor changes, and to 
present your work.
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Reflection
•	 Make notes in your PD Journal.

•	 Think about three ways in which you can use Microsoft 
OneNote in your class. 

•	 If you have not used it, why not?

Let’s recap what you know about  
Microsoft OneNote 

Microsoft OneNote

During Session 7 of this course, we dealt with the features and 
functions of using Microsoft OneNote on a computer in great 
depth. Here is a summary of some of the useful functions of the 
desktop app.

•	 OneNote allows creating separate notebooks for different 
subjects or projects.

•	 Notebooks can be shared with learners or colleagues for 
easy collaboration.

•	 Create to-do lists and checklists to stay organised.

•	 The app has a powerful Search Function to quickly find 
previously saved notes, text, or handwritten notes.

•	 You can insert various media files such as pictures, videos, 
and audio recordings into a notebook.

•	 The Ink to Text Feature converts handwritten notes into 
typed text.

•	 A built-in collaboration feature allows multiple users to edit 
a notebook simultaneously.
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Using Microsoft OneNote Online 

You can create a Microsoft OneNote Notebook.

1.	 Sign into your Microsoft Account.

2.	 Sign into OneNote Online.

3.	 Click on the Notebooks Tab. 

4.	 Click on Add Notebook. 

5.	 Give your notebook a name.

6.	 Choose whether you want to keep it private or share it with 
others. Add a notebook cover (optional).

7.	 Click Create.

You can add sections and pages.

1.	 Click on the Plus Sign Icon next to the notebook name to 
add a new section.

2.	 Type in a name for your new section.

3.	 Click on the Plus Sign Icon next to the section name to add 
a new page.

4.	 Type in a name for your new page.

You can add content to pages and collaborate with learners.

1.	 Click on the page to add text.

2.	 Click on the Insert Tab to add images, tables, and other 
types of content.

3.	 Click on the Share Button to share your notebook.

4.	 Enter the email addresses of the learners you want to share 
it with.

5.	 Set permissions to control who can edit the notebook.

Task
•	 Open a Microsoft OneNote Notebook on your computer.

•	 Open the same notebook on Microsoft OneNote Online. 
Add something to your notebook.
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Using the Microsoft OneNote mobile app

You can use the Microsoft OneNote mobile app.

1.	 Go to your device’s App Store. If you are using an Android 
device, this will be the Google Play Store.

2.	 Download and install the OneNote App on your device.

3.	 Create a new notebook, name it, and choose where to store 
it.

4.	 Add sections and pages to your notebook.

5.	 Start taking notes, add formatting, images, and templates.

6.	 Collaborate with learners by sharing the notebook and 
granting permission for them to view or edit it.

Task
•	 Open the notebook you used previously on the Microsoft 

OneNote mobile app. Can you see the addition you made 
to your notebook here?

•	 Was it easy to access and work with the same notebook 
across the three versions of Microsoft OneNote? 

Desktop, online or mobile app?

To enhance your digital fluency, use this table showing a 
comparison of Microsoft OneNote on a desktop, in a browser 
and on a mobile device to decide when you would like to use 
which version of the app.

Feature

Ability to use optical character recognition (OCR) to 
translate handwritten notes into text

Yes No No

Outlook integration with tasks Yes No No

Edit embedded files Yes No No

Can work without internet connection Yes No Yes
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As with the other Microsoft Apps, the most advanced OneNote 
Features are only available in the paid-for app that you will use 
on a computer. The mobile and browser apps are convenient 
add-ons though, for you to work on your notes at any time, 
and anywhere. You can use OneNote on your mobile device 
when you are offline, and your changes will sync when you 
connect to the internet again.
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Microsoft OneDrive
Key features of Microsoft OneDrive

Here is a list of some important features of Microsoft OneDrive.

•	 OneDrive offers automatic backup and sync functionality.

•	 The app offers easy file sharing with View-only or Editing 
Access.

•	 It allows version control for accessing older file versions.

•	 OneDrive integrates seamlessly with other Microsoft Office 
Apps.

•	 OneDrive offers security and privacy features, including 
encryption and two-factor authentication.

Using Microsoft OneDrive Online

You can use Microsoft OneDrive Online. 

1.	 Sign into your Microsoft Account.

2.	 Sign into Microsoft OneDrive Online.

3.	 Upload files to OneDrive.

4.	 Create folders to organise files. 

5.	 Share files with learners by right-clicking on a file and 
selecting Share.

6.	 Collaborate on files with learners in real-time by sharing the 
file and selecting the Allow Editing Option.

Reflection
•	 Make notes in your PD Journal.

•	 Think about three ways in which you can use Microsoft 
OneDrive in your class. 

•	 If you have not used it, why not?
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Using the Microsoft OneDrive mobile app

You can use the Microsoft OneDrive mobile app.

1.	 Go to your device’s App Store. If you are using an Android 
device, this will be the Google Play Store.

2.	 Download and sign into OneDrive.

3.	 From the main screen of the app, access your files and 
folders by tapping on them.

4.	 Edit files directly from the OneDrive App by tapping on the 
file and opening it in the appropriate app. Make changes 
and save back to OneDrive.

5.	 To share a file, tap on the file, and tap the Share Icon. 
Choose to share via email or link and add email addresses 
or copy the link to share.

6.	 To upload a file, tap the Upload Icon and select the file from 
your device or take a photo. Choose which folder to upload 
it to. 

7.	 Organise your files by creating folders in OneDrive. Tap the 
New Folder Icon, name the folder, and choose where to 
save it.

Task
•	 Open a document in Microsoft OneDrive on your 

computer. Make a change to the document.

•	 Open the same document on Microsoft OneDrive Online. 
See if the change you made on the desktop app is 
reflected in the app on the browser. Make another change 
to the document.

•	 Open the same document on the Microsoft OneDrive 
mobile app. Make sure both of your changes are 
reflected.
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Desktop, online or mobile app?

To enhance your digital fluency, use this table showing a 
comparison of Microsoft OneDrive on a desktop, in a browser 
and on a mobile device to decide when you would like to use 
which version of the app.

Feature

Can work without internet connection Yes No Yes

Microsoft OneDrive basically shares all its features across the 
desktop app, the mobile app and OneDrive online in a browser.

OneDrive Online can of course only work when you have an 
internet connection, because it is used in a browser. You can 
use OneDrive on your desktop or your mobile device when you 
are offline, and your changes will sync once you are connected 
to the internet again.
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About the Final Assessment
At the end of this training session, you will be asked to 
complete the Final Assessment.

If you complete the Final Assessment successfully, you will 
qualify for your virtual badge and certificate. You can see a 
sample here.

SA
M
PL
E
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Final Assessment
Indicate the ONE correct response for each question.

1 What is Microsoft Word used for?

a Creating spreadsheets.

b Creating presentations.

c Creating documents.

d Creating notes.

2 Which of the following is NOT a feature of Microsoft Excel?

a Creating charts and graphs.

b Sorting and filtering data.

c Creating documents.

d Performing calculations and formulas.

3 What is the main purpose of PowerPoint?

a Creating documents.

b Creating spreadsheets.

c Creating presentations.

d Performing calculations and formulas.

4 What is OneNote used for?

a Creating presentations.

b Creating documents.

c Taking notes.

d Performing calculations and formulas.

5 Which of the following is NOT a feature of OneDrive?

a Storing and sharing files.

b Creating presentations.

c Accessing files from any device.

d Collaborating with others.
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Indicate the ONE correct response for each question.

Final Assessment (continued)

6 Which version of Microsoft Word allows for easy collaboration among multiple users?

a Microsoft Word desktop app.

b Microsoft Word Online.

c Microsoft Word mobile app.

d All of the above.

7 Which of the following is NOT a way to format text in Microsoft Word?

a Bold

b Italic

c Strikethrough

d Adding a border.

8 What is the purpose of a Microsoft Excel Function?

a To perform calculations and formulas.

b To create charts and graphs.

c To format text.

d To insert images and videos.

9 Which of the following is NOT a type of slide layout in PowerPoint?

a Title Slide.

b Two-Column Text.

c Blank Slide.

d Image Gallery.

10 Which version of OneNote allows for easy access and note-taking on mobile devices?

a OneNote desktop app.

b OneNote Online.

c OneNote mobile app.

d All of the above.
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Indicate the ONE correct response for each question.

Final Assessment (continued)

11 What is the purpose of a chart in Microsoft Excel?

a To create visual representations of data.

b To format text.

c To insert images and videos.

d To perform calculations and use formulas.

12 Which of the following is NOT a way to share a PowerPoint Presentation with others?

a Emailing the file.

b Uploading to OneDrive and sharing a link.

c Uploading to YouTube.

d Presenting live over the internet.

13 Which version of OneDrive allows for easy access and file sharing on-the-go?

a OneDrive desktop app.

b OneDrive Online.

c OneDrive mobile app.

d All of the above.

14 Which of the following is NOT a way to organise notes in OneNote?

a Creating notebooks.

b Adding tags.

c Adding formulas.

d Creating sections and pages.

15 What is the main purpose of OneDrive?

a To create documents.

b To perform calculations.

c To store and share files.

d To create presentations.
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Uncertain about all 
the new terms you are 

learning about? Download our 
extensive Using your laptop to 
make a real difference to your 

teaching Glossary booklet 
to look at terms and technical 

explanations.

Additional Resources
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